
READ ME FIRSr! 

ELECTRONIC ARTS PRESENTS 

CD-ROM CLASSICS 
THE LOST FILES 

OF SHERLOCK HOLMES 

The system requirements and procedure for starting and playing The Lost Fi/,es of Sherlock Holmes are 
listed below. Please refer to the on-line documentation for all other gameplay information (see Using 
the On-line Documentation below). 

Getting Started 
The Lost Files of Sherlock Holmes comes on 1 CD. You need 571K of free RAM to install and play the 
game. 

Installing the Game 
After booting your system with DOS, do the following: 

1. Insert the CD in your CD drive. 

2. Type d: (or the letter of your CD drive, if different) and press .J (ENTER) to move to the 
CD drive. 

3. When you see the "D:" prompt, type install .J . 

4. The installation menu appears. Follow the menu prompts to install the game(s) and on-line 
documentation reader. 

• To highlight a menu item, press the arrow curser keys up/down. 

•To activate the highlighted item, press .J. 

You can install the game and documentation reader separately or at the same time. 

Documentation and a preview of new EA tides are provided on-line. 
If you would like to receive the printed manual, please see the order form 

on the back cover. 



Starting the Game 
Sysrem requirements: 

571 K (584,704) base RAM 
EMS for digiral speech 
15/29 (minimum/fasr) MB hard disk space 
DOS 3.3 or grearer 
Mouse recommended, keyboard and joysrick supported 
Adlib", Sound Blasrer", and Roland sound cards supported 

1. Move ro rhe direcrory where rhe game is insralied. By defaulr ir is insralied in C:\EA\HOLMES, 
so you would rype 

c:.J 
cd\ea \holmes.J 

2. Before running Sherlock Holmes for rhe firsr rime rype insrali .J ar rhe C:\EA\HOLMES 
prompt. This will bring you ro rhe insraliarion oprion screen. 

3. To srart rhe program rype holmes .J at rhe C:\EA\HOLMES prompt. 

•To bypass rhe incroduction, rype game .J at rhe C:\EA\HOLMES prompt. 

Note: If your mouse is connected ro Com 2 and you have a sound card on your system, you may 
need ro use rhe keyboard controls on rhe first screen of rhe game. When rhe second screen 
appears, you will be able ro use your mouse. If you are experiencing orher mouse difficulties, we 
recommend updating your driver, or obtaining a true Microsoft mouse driver. 

The Installation Options Screen 
The options you can select from this screen are: 

•Change Sound Devices. 

I . Use rhe Anow Keys ro highlight Change Sound Devices and press ENTER. The Change Sound 
Devices submenu will appear. 

2. There are two sound devices for which you may choose oprions: A Musical Device and a Digital 
Device. The musical device will play rhe music, and rhe digital device will play all sound effects 
and voices. 

3. When selecting the Musical Device, use rhe Arrow Keys ro select the sound device insralled in 
your computer system. The soundboard your computer is equipped with will be highlighred. 
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The available oprions are: 

4. 

No Music 
Adlib Sound Board 
Sound Blaster 
Roland MT-32 or LAPC-1 

When selecring rhe Digital Device, use rhe Arrow Keys to selecr the so~nd ~evice i~st~ed in 
your computer sysrem. The sound board your compurer is equipped w1rh will be h1gh11ghted. 
The available oprions are: 

No Sound 
Sound Blaster 
Tandy SL, TL, RL 
Tandy TX, EX, HX, SX 

5. When you have selecred the Music Device and Digital Device you wanr, highlighr Return ro 
Main Menu and press ENTER. 

Note: If your compurer is equipped wirh Sound Blasrer but you are nor getting any sound while 
playing Holmes, make sure rhat rhe sound card is ser ar eirher Interrupt 7 or Interrupt 5. For 
information on serting rhe sound card interrupt, see your Sound Blasrer manual. Please note 
rhat only certain sequences in rhe game contain recorded voices. 

•Change Input Device 

1. Use rhe Arrow Keys ro highlighr Change Input Device and press ENTER. The Change Input 
Device submenu will appear. 

2. This option chooses which inpur device you will use ro play Holmes. Use rhe Arrow Keys ro 
highlight the input devices you want ro use ro play Holmes. 

3. When you have highlighted rhe inpur device options you want, press ENTER. 

4. Use rhe Arrow Keys ro highlight Return ro Main Menu and press ENTER ro leave rhe Change 
Input Device submenu at any rime. 

•Change Memory Usage 

l. Use rhe Arrow Keys ro highlighr Change Memory Usage and press ENTER. 

2. This option is imporrant if your computer has expanded memory capaciry. If it does.' use rhe. 
Arrow Keys to highlighr Use Expanded Memory and press ENTER. Your computer wtll. use rh1s 
memory to score graphics files rhar it would otherwise have to load from your hard drive. This 
will make rhe game play faster. 
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Note: If you are using DOS 5's EMM386 expanded memory manager, and want to hear the dig
itized speech in Holmes, the defaulr OMA serring of 16 will have to be increased. Supporr for 
EMM386 can be achieved by adding the paramerer d=40 after rhe EMM386 entry in the CON
FIG.SYS file as shown here: 

device=c:\dos\emm386.exe d=40 

See your DOS manual for information about ediring files. 

3. If your computer does not have expanded memory, or you don'r want co use irs expanded mem
ory, use the Anow Keys to highlight No Expanded Memory and press ENTER. 

4. Use the Arrow Keys to highlight Return to the Main Menu and press ENTER to leave the Change 
Inpur Device submenu at any time. 

Saving, Loading, and Quitting a Game 
Note: To highlight or select oprions throughout Holmes while using the keyboard, 
press ENTER. 

Saving a Game 
I. Press F or use the mouse or joystick ro highlighr and click on the Files box. 

2. When the Files Menu appears, press S or use rhe mouse or joystick to highlighr Save. 

3. Use rhe pointer to highlight the Saved Game File in which you want to score the game you are 
saving. There are 30 Saved Game Files; so, for example, if you wanted to save a game in file I, 
you would highlighr file I. To scroll up and down through the Saved Game Files, highlight the 
Up or Down Arrow Butrons. 

4. Enter a name for rhe game you are saving, such as Game I, Game A, ere., and press ENTER. The 
game is saved and you then are returned to the game. 

Note: If a game is Saved in a file that already contains a Saved game, rhe new Saved game will 
overwrite the old one. 

Nore: You may press E or use the mouse or joystick to highlight Exit the Files Menu and return 
ro the game only before highlighting a Saved Game file. If you make an error while ryping a 
name for your Saved Game file, press the ESC key. 

Note for Keyboard Users: A shorrcut has been provided to help you quickly save games 1-9. 
When the Files Menu is on screen, you may simply rype the number (I-9) of the game you wanr 
to save and enter a name for ir. To save games I 0-30, you must move the poinrer to the slor in 
which you want to save a game and press the space bar. You can then rype the name you want to 
save the game under. 
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Loading a Saved Game 

I. Press F or use the mouse or joystick to click on Files. 

2. When the Files Menu appears, press Lor use rhe mouse or joystick to highlighr Load. 

3. Use the poinrer co highlighr rhe Saved Game File you wam to Load. That game will load imme
diately. If you change your mind about Loading a Saved Game, press E. Use the mouse or joy
stick co click on Exit only before highlighring a Saved Game file. 

Note: If you Load a Saved Game while you are playing another game without saving the game in 
progress, the game in progress will nor be Saved. 

Quitting a Game 
l. Press F or use the mouse or joysrick to click on Files. 

2. When the Files Menu appears, press Q or use the mouse or joystick to highlighr Quit. 

3. You will be asked "Are you sure you want ro Quit?" Press Y or use the mouse or joystick to click 
on Yes if you do want co Quit, or press N or use the mouse or joystick ro click on No if you 
don't. If you do Quit, you will return to the DOS screen. 

Note: If you Quit a game without Saving ir first, the game state will be lost. 

4. Press E or use the mouse or joysrick co highlight EXIT to leave rhe File menu and rerum to the 
game only before selecting Quir. 

Commands 
Note: In the following insuuctions, when cold co click the left burron you may also press ENTER or the 
space bar; and "left joystick butron" refers co Burton l and "righr joystick butron" refers ro burron 2. 

Autohelp 
The game is equipped with an Auro Help feature. If Auro Help Left is selecred from the Set Up menu 
and no other commands are highlighted, the Look, Talk, Open, and Close Commands will become 
highlighted when the on screen poinrer passes over an object or person one of those commands can 
be used upon . If Auro Help Right is selected from rhe Set Up menu, the right mouse burron musr be 
held down for Auto Help co work. See the explanation of rhe Ser Up submenu for more information 

on how to use Auto Help. 
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Selecting Objects 
An objecr can be selecred if irs name appears in rhe srrip near rhe borrom of rhe screen when rhe on 
screen pointer is over rhe objecr. When Aura Help Left has been selecred from rhe Ser Up menu, 
objecrs can be selected by using rhe mouse or joystick ro move rhe on screen pointer over rhe objecr 
and clicking rhe left joystick or mouse burron; or by using rhe arrow keys ro move rhe on screen 
pointer over rhe object and pressing ENTER or rhe spacebar. If Auto Help Righr has been selecred from 
rhe Set Up menu, objecrs can be selecred by using rhe mouse or joystick ro move the on screen point
er over rhe object and releasing rhe righr joysrick or mouse burron. 

Selecting Commands 
When Aura Help Left has been selecred from rhe Ser Up menu, commands are selected with pressing 
the lefr mouse or joystick burron and deactivared wirh rhe right mouse or joystick butron. When Aura 
Help Righr has been selecred from rhe Set Up menu, commands are selecred wirh rhe righr joystick or 
mouse burcon. Commands can always be selecred by using rhe cursor keys to move rhe on screen 
pointer over a command burron and pressing ENTER. 

Interactive Commands 
Use rhe Inreractive Commands in Holmes to interacr with people or objects. These commands are 
Look, Move, Talk, Pick Up, Open, and Close. Inreractive Commands can be activated wirh a Key 
Command, or by pointing and clicking on rhe command with your mouse or joystick. The target or 
subjecr of a command can be chosen by moving rhe on-screen poimer wirh rhe arrow keys, mouse, or 
joystick. Bur ro give a Command, you must click rhe mouse or joystick burron when rhe Command is 
active and rhe target or subject of rhe command has been chosen. 

Note: The ESC key on your keyboard will cancel most commands and back you out of rhe Text Entry 
boxes. 

Key Commands 

Press rhe lercer keys below to give rhe indicared commands. 

Look 

L Look at an object or person. Gives a brief description of whar you're Looking at. The on-screen 
pointer will become a magnifying glass when rhis Command is active. 

Move 

M Move an objecr 

Talk 
T Talk to someone 
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U Scroll Up rhrough messages. This option will be available only when there are more rhan one 
message, or when rhere is one message bur it is too long ro fir in rhe Dialog Box. 

D Scroll Down rhrough messages. This option will be available only when rhere are more rhan one 
message, or when there is one message bur it is too long to fir in rhe Dialog Box. 

1-6 Select a dialog message. If rhere is more rhan 1 dialog message ro choose from, press rhe number 
key rhat corresponds ro rhat dialog message or select rhe message you want wirh rhe pointer. 

Pick Up 

P Pick Up an objecr. 

Open 

0 Open a door, drawer, cabinet, etc. 

Close 

C Close a door, drawer, cabiner, ere. 

Inventory Commands 
Use rhe Inventory Commands in Holmes to affecr an object in Holmes' inventory or in 221 B Baker 
Streer. These commands are Inventory, Use, and Give. To acrivate an Inventory Command, click on it 
using rhe Mouse or use rhe following key commands: 

Key Commands 

Press rhe lercer keys below ro give rhe indicated commands. 

Inventory 
I Display rhe Inventory of everyrhing Holmes' is carrying. You can use rhe following subcom

mands when rhe Inventory command is active. To select a subcommand, use rhe Key Command 
given below, or point and click on ir using rhe joystick or mouse: 

Use 

L Look at and get a description of an object in Holmes' inventory . 
U Use an objecr. 
G Give an object ro someone else. 
E Exit the Inventory command. 

U Use an object, eirher by irself or in conjuncrion with anorher object. You must selecr rhe object 
you want ro Use, rhen selecr rhe recipienr by pointing and clicking wirh the mouse or joystick. 
You can use rhe following subcommands when the Use command is active. To selecr a subcom
mand, use rhe Key Command given below, or point and click on it using rhe joysrick or mouse: 
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L Look at and get a description of an object in Holmes' inventory . 
U Use an object. 
G Give an object to someone else. 
E Exit the Use command. 

Give 
G Give an object to a person. You must select the object you want to Give, then select the recipient 

by pointing and clicking with the mouse or joystick. You can use the following subcommands 
when the Give command is active. To select a subcommand, use the Key Command given below, 
or point to it and click using the joystick or mouse: 
L Look at and get a description of an object in Holmes' inventory . 
U Use the object. 
G Give the object to someone else. 
E Exit the Give command. 

The Journal 
Press J, or select Journal with the mouse or joystick, to open Watson's Journal. The Journal is Dr. 
Watson's record of the investigation. You can use the journal to refresh your memory about past con
versations and where those conversations took place. You cannot change the journal itself; you cannot 
erase Watson's records nor can you enter other information in the Journal. 
D Go forward one page 
U Go back one page 
F Go to the First Page 
L Go to the Last Page 
A Go Ahead 10 pages 
B Go Back I 0 pages 
S Search the Journal entries for a particular word or phrase. This command brings up the 

Search Box. Enter the word or phrase you want to search for in the requester on the right 
hand side of the Box. Click on the following commands using the mouse or joystick to acti
vate the command: 
Forward Search Forward through the journal 
Backward Search Backward through the journal 
Exit Exit the Search Box and return to the Journal commands 

p Print Text. This command calJs up the Print Text box. The commands in the Print Text box 
must be selected with the pointer; they have no key commands. 
•Print will print a text version of the journal on your printer. Printing will auromatically 
exit the Print Text box. 
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NOTE: If you experience difficulries in printing, first make certain that your printer is turned 
on and connected properly. If you continue to experience problem , save the Journal. Then, Save 
your game and Quit to get to the DOS prompt. Next, type the following command from the 
DOS prompt (Be sure to Save your game before quitting!) : 

COPY <filename>.PRN PRN 

For example: If you saved the Journal with the name SHERLOCK, you would type the follow
ing: COPY SHERLOCK.PRN PRN and press ENTER. The Journal is then printed on your 
printer. 

Consult your DOS Manual for more information. 
•Save will save the Journal to a specified file name; you must enter a name in the requester box 
before you can save the Journal. Saving will automatically exit the Print Text box 

•Exie will exit the Prine Text box. 

E Exit the Journal screen and return to gameplay 

Set Up Options 
You can use the Set Up submenu to modify Sound, Control, and other options during game play. You 
can change a Set Up option by selecting it using the Joystick or Mouse or with the following key 
commands (for more derails, see your manual) : 

M Toggle Music On/Off 
P Toggle Portraits On /Off 
J Toggle the Joystick On/Off 
N New Font Style; toggles berween 3 font styles 
S Toggle che Sound Effects On/Off 
V Toggle Voices On/Off 
W Windows Slide/Appear 
C Calibrate Joystick 
A Auto Help Lefr/Right. 
F Fade By Pixel/Directly 
K Keypad Slow/Fast 
E Exit Set Up options screen, return co gameplay 
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Files 
You can use the Files box to Save Games, Load Saved Games, and 
Quic Holmes. These options are explained in detail in the Load, Save, and Quiccing the Game section 
in this Command Summary Card. 
S Save a game. You muse encer a name for a Saved Game. 
L Load a Saved game. You muse select the Saved Game you wane to Load. 
U Scroll Up through the Saved Game Files. 
D Scroll Down chrough the Saved Game Files. 
Q Quic the game. When the requester appears, press Y if you do wane co Quit, or press N if 

you don't. 
E Exie the Files box and return co game play. 

Using the On-Line Documentation 
DOS USERS: 
System requirements for DOS: 

386- or 486-based PC (486 recommended), DOS 3.3 or higher 
2 MB of available RAM (4 MB or more recommended) 
4 MB hard disk space 
Microsoft-compatible mouse 
VGA graphics 
Poscscripc or Laserjer primer supported 

To install the DOS Adobe Acrobat on-line document reader: 

1. Insert the CD in your CD drive. 

2. Type d: (or the letter of your CD drive, if different) and press .J (ENTER) to move to the 
CD drive. 

3. When you see the "D:" prompt, type install .J. 

4. The inscallarion menu appears. Follow the menu prompts co inscall the on-line documenta
tion reader. 

To highlight a menu item, press the arrow cursor keys up/down. 

To accivate the highlighted item, press .J. 

NOTE: If you have Microsoft"' Windows™ installed, we recommend thac you install the Windows 
version of the Adobe Acrobat reader for greater ease of use when reading the on-line manuals. 
See below for instructions on installing Acrobat for Windows. 
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To start Adobe Acrobat for DOS: 
I. The CD muse be in the drive to run the program. 
2. Move to rhe directory where Adobe Acrobat is installed. By defaulc, ir is installed in 

C:\EA\ACROBAT, so you would type: 
c: .J 

cd \ea \acrobat .J 

3. Type acrobat .J to stare the program. 

NOTE: If you receive an "ACROBAT.IN!" error message when running Acrobat, see Making a 
DOS Boot Disk below. 

WINDOWS USERS: 
System requirements for Windows: 

386- or 486-based PC (486 recommended) 
4MBRAM 
Microsoft Windows 3.1 or greater 

To install Adobe Acrobat for Windows: 
1. Insert che CD in your CD drive. The CD muse be in che drive to install and run the pro

gram. 
2. Starr Windows. 
3. From the Windows Program Manager, choose RUN ... from the File menu. The Run dialog 

box appears. 
4. Type d:\acroread.exe. (If your CD-ROM isn'c drive D:, substicuce the appropriate letter for 

'd' .) 
5. Click OK or press ENTER and follow che instructions on your screen. 

To start Adobe Acrobat for Windows: 

1. Scarr Windows and ensure rhac the CD is in the drive. 

2. If the Acrobat Reader 2.0 icon is noc visible in the Program Manager window, double-click 
on the Acrobat program group icon. The Acrobat window opens. 

3. Double-click the Acrobat Reader 2.0 icon. The program begins. 

To open a document file (DOS and Windows): 

Select Open from the File menu. Use the dialog box to select the directory of the file (The 
on-line documents are in the \DOCS directory on the CD). Double-dick on a file to open 
i c. The files are: 

HOLMES.PDF 
HOLMESRF.PDF 
GAMES.PDF 

Holmes player's guide. 
This reference card. 
Information on other game titles. Noe all rides may be available 
in your area. 
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To learn how ro use Adobe Acrobat: 

Open the file HELPREAD.PDF in the \DOCS directory on the CD. Complete Acrobat 
instructions are contained in this file. 

Quick Acrobat Tips: 

Each document file contains bookmarks that function as an electronic table of contents. To 
view bookmarks, select Bookmarks and Page from the View menu. The bookmarks appear 
ro the left of the document window. 
To jump ro the page associated with a bookmark, double-dick on the page icon next ro the 
bookmark. 
To show or hide any subordinate bookmarks, click the triangle ro the left of bookmark. 
To move through the document one page at a time, click the Previous or Next Page buttons 
or press the left/right arrow cursor keys. 
To move through a document one screen ar a time, click above or below the scroll box in the 
scroll bar or press the PAGE Ur/PAGE DOWN keys. 

MAKING A DOS BOOT DISK 
If you are having trouble installing your program, experiencing lockups or other problems, we suggest 
you rry starting up your system with a DOS boot disk. Here are the steps for creating a DOS boor 
disk. Please follow these steps exactly. 

IMPORTANT: To create a DOS boot disk you need a blank disk the same size as your A: drive. 

1. Type C: and press ENTER. 

2. Insert a blank disk into drive A: . 

3. Type Format a:/s and press ENTER. 

Nore: If you are formatting low density disks on a high density drive, use the following com
mands in place of Srep 3: 

5.25" low density disk: Type Format a:/s/n:9/t:40 and press ENTER. 

3.5'' low density disk: Type Format a:/s/n:9/t:80 and press ENTER. 

4. You are prompted ro insert a blank disk into drive A:. Do so if you haven't already, and press 
ENTER. 

5. Once the disk is finished formacring, you are asked ro label (name) the disk. Type in a label or 
press ENTER for no label. 

6. You are now asked whether you wish ro format another disk. Type N and press ENTER. 

7. You must now create a CON FIG.SYS file on your boot disk by typing the following at the C: 
prompt: 

edit a:\config.sys .J 
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When the blue edit screen appears, type in: 

device=c:\dos\himem.sys 
device=c:\dos\emm386.exe 2048 RAM 
dos=high, urnb 
files=25 
buffers=25 
devicehigh=(INSERT THE PATH OF YOUR CD ROM DRIVER) 

ACROBAT NOTE: If you receive any "ACROBAT.JN!" e"or messages from the DOS Acrobat document 
reader program, add or modifJ the fallowing lines to the CONF!G.SYS file on your boot disk: 

FILES=30 
BUFFERS=30 

8. Exie and save this file by typing: 
ALT-F 
x 
y 

9. You will also need an AUTOEXEC.BAT file on you boot disk. To create one, type: 
edit a:\autoexec.bat <ENTER> 

When che blue edit screen appears, type: 
prompt $p$g 
path=c:\dos 
lh c:\(PATH)\mscdex.exe (all parameters from the original AUTOEXEC.BAT on drive C:) 
lh c:\mouse\mouse 

Note: If your mouse driver is named something else or is not in a directory called MOUSE, alter 
this last line accordingly. 

10. Exit and save chis file by typing: 
ALT-F 
x 
y 

IMPORTANT: Remember ro boor your PC from the DOS boor disk whenever you install the game, 
and every rime you play Sherlock Holmes (see below). 

To start your machine using the DOS boot disk 
1. Insert the DOS boor disk into drive A: then restart you machine. The computer boors up ro 

the A:> prompt. 
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2. Type C: and press ENTER to return to you hard drive. 

For more information consult your DOS users manual. 

Technical Support 
If you have questions about the program, our Technical Support Department can help. If your ques
tion isn't urgent, please write to us at: 

Electronic Arts Technical Support, P.O. Box 7578, San Mateo, CA 94403-7578 

Please be sure to include the following information in your lercer: 
Product nan1e 
Type of computer you own 
Amount of and configuration of memory . . . 
Any additional system information (like type and make of monitor, video card, printer, 
modem etc.) 
Type of operating system or DOS version number 
Description of the problem you're having 

If you need to talk to someone immediately, call us at ( 415) 572-ARTS Monday through Friday 
between 8:30 am and 4:30 pm, Pacific Time. Please have the above information ready when you call. 
This will help us answer your question in the shortest possible time. 

If you live outside of the United Scates, you can contact one of our other offices. 

In the United Kingdom, contact: 
Electronic Arts Lrd. , P.O. Box 835, Slough SL3 8XU, UK. Phone (044) 753546465 

In Australia and New Zealand, contact: 
Electronic Arts Pry. Ltd., P.O. Box 432, Southport Qld 4215, Australia 

Within Australia call: Phone: (075) 711 811 

Within New Zealand call: 
Phone: +61 75 711 81 l between 9am-5pm Eastern Standard Time 

Limited Warranty . 
Electronic Arts ("EA") warrants to the original purchaser of the computer software product, for a peri-
od of ninety (90) days from the date of original purchase (the "Warranty Period"), that under. normal 
use, the media and the user documentation are free from defects in materials and workmanship. 
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Warranty Claims 
To make a warranty claim under this limited warranty, please return the product ro the point of pur
chase, accompanied by proof of purchase, your name, your return address, and a statement of the 
defect. OR send rhe disk(s) to us at the above address within 90 days of purchase. Include a copy of 
the dared purchase receipt, your name, your return address, and a statement of the defect. EA or its 
authorized dealer will, at our option, repair or replace the product and return ir ro you (postage pre
paid) or issue you with a credit equal to the purchase price. 

To replace defective media after the 90-day warranty period has expired, send the original disk(s) to 

the above address. Enclose a statement of the defect, your name, your return address, and a check or 
money order for $7.50. 

The foregoing stares the purchaser's sole and exclusive remedy for any breach of warranty with respect 
to the software product. 

Limitations 
THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES AND NO OTHER REPRE
SENTATIONS OR CLAIMS OF ANY NATURE SHALL BE BINDING ON OR OBLIGATE 
ELECTRONIC ARTS. ANY IMPLIED WARRANTIES APPLICABLE TO THIS SOFTWARE 
PRODUCT, INCLUDING WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, ARE LIMITED TO THE NINETY (90) DAY PERIOD DESCRIBED 
ABOVE. IN NO EVENT WILL ELECTRONIC ARTS BE LIABLE FOR ANY SPECIAL, INCI
DENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM POSSESSION, USE, OR 
MALFUNCTION OF THIS ELECTRONIC ARTS SOFTWARE PRODUCT. 
Some stares do nor allow limitations as to how long an implied warranty lasts and/or exclusions or 
limitarions of incidental or consequential damages so the above limitations and/or exclusions of liabil
ity may nor apply to you. This warranty gives you specific rights, and you may also have other rights 
which vary from state to stare. 

Need Help? Call EA's HINTS & INFORMATION HOTLINE for recorded hints, tips, and pass
words 24 hours a day, 7 days a week! 

In the US, dial 900-288-HINT (4468) In CANADA, dial 900-451-4873 
75c per minute (95c for first minute) . $1.15 (Canadian) per minute. 

If you are under 18, be sure to get a parent's permission before calling. Hotline requires a Touch-Tone 
telephone. Call length determined by user; average length is four minutes. Messages subject to change 
without notice. 
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NOTE TO HOTLINE CALLERS: 
To help you quickly locate the information you need, Electronic Arts will gladly send you printed 
menus. To receive a copy, please send your name, address, title of game you wane the menu to, and 
the hardware (Genesis, Super NES, IBM, etc.) to: 

Hotline Menus, P.O. Box 7578, San Mateo, CA 94403-7578 

NOTICE 
ELECTRONIC ARTS RESERVES THE RIGHT TO MAKE IMPROVEMENTS IN THE PROD
UCT DESCRIBED IN THIS MANUAL AT ANY TIME AND WITHOUT NOTICE. 

THIS MANUAL AND THE SOFTWARE DESCRIBED IN THIS MANUAL ARE COPYRIGHT
ED. ALL RIGHTS ARE RESERVED. NO PART OF THIS MANUAL OR THE DESCRIBED 
SOFTWARE MAY BE COPIED, REPRODUCED, TRANSLATED, OR REDUCED TO ANY 
ELECTRONIC MEDIUM OR MACHINE-READABLE FORM WITHOUT THE PRIOR 
WRITTEN CONSENT OF ELECTRONIC ARTS, P. 0. BOX 7578, SAN MATEO, CALIFOR
NIA 94403-7578, ATTN: CUSTOMER SUPPORT. 

DOCUMENTATION © 1995 ELECTRONIC ARTS. ALL RIGHTS RESERVED. 

SOFTWARE© 1995 ELECTRONIC ARTS. ALL RIGHTS RESERVED. 

To order the primed manual, please send this form along with check or money order for $5.00 (US$, 
drawn on US or Canadian bank). 

Electronic Arts Direct 
P.O. Box 7530 
San Mateo CA 94403 
Arm: CD Classic Manuals. ELECTRONIC ARTS" 

Address _____________________________ _ 

City ________________ State _____ Zip ______ _ 

The Lost Files of Sherlock Holmes 

If you need to contact us regarding the documentation, please call us at (415) 513-7555 
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